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How To Use This Guidebook

Welcome to the 2025 Annual CDM+ Users Conference! This guidebook is designed to help you navigate
the event with ease so you can make the most of your training experience. Inside you'll find everything
you need to plan your days, choose the right sessions, and locate classrooms.

What's Inside

» Class Schedule - An overview of sessions, times, and dates

» Suggested Tracks - Tailored paths designed for specific roles in your organization

* One on One Support - Instructions for how to book a one-on-on session in person with a CDM+
support technician

» Table of Contents - Quickly locate sections of this guide

» Class Pages - Each class has it's own page with outling, time, and location

- Notes Pages - Following each class section there is space provided for jotting down key takeaways,
reminders, etc

- Hotel Map - At the back of the book, a map to help you navigate to meeting spaces and key conference
areas

Tips For Success
We recommend beginning with the table of contents to see the structure of the guide, then using the
class schedule to get a daily overview of what's happening. Be sure and review the map and schedule

ahead and time and mark classes that are of interest to you.

We also encourage you to explore classes beyond your regular interests and discover all that CDM+ has to
offer.

If you are interested in a one-on-one support session, book your slot early! If you book a session and end
up not needing it, please cancel your appointment to free up the time for another attendee. You can

cancel a session using the confirmation email or just stop by the help desk and we'll be happy to assist.

Keep this guidebook handy during the day for quick reference.

Online Guide

All of the material in this guidebook is also available on the dedicated 2025 CDM+ Annual Users
Conference website. Simply scan the QR code on the cover of this book or visit auc2025.cdmplus.com/auc
from your phone, tablet, or computer. Each class page in this book also has a QR code linking directly to

the page for that class.

The online guide includes the same class content as this book and adds clickable links that take you
directly to the CDM+ Help Center. There you'll find step-by-step instructions and related resources.

You are NOT required to use the online resources with each class. Just come to the class and follow the
presenter to start learning!

We're so glad you're here and look forward to an engaging conference experience!
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1-on-1 Scheduled Support

Tech support is always available on a first-come, first-served basis in the Computer
Lab. But sometimes you need a little extra focus and that's where our 1-on-1
scheduled appointments come in.

Booking an Appointment

You can book an appointment by scanning the QR or
visiting https://suransystemsinc.setmore.com/ and
completing the form. (please note spaces are limited).

Support appointments are blocked for 30 minutes and are a great alternative to
taking a class as they occur during regular class time.

Here's How it Works

* Book your appointment

« Arrive at the computer lab a few minutes before your appointment

 Let a Suran staff memlber know you have are there for an appointment and
they'll connect you with a support specialist

Tips for Success

» Have your laptop connected to CDM+ and ready to log in, or have your
credentials handy if you need to use a lab computer

» Please be respectful of other attendee’s appointments

« If you need additional time beyond the appointment, the support specialist can
book a follow-up time with you (including after you return home from the
conference)

Need to Cancel or Re-schedule?

No problem! Just follow the instructions in the confirmation email or stop by the
Help Desk and we'll be happy to help!
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Getting Started Membership

A Mon 9:45 - 11:00 | Bluegrass B @® Don Howell
3% Tue1:45 - 3:00 | Bluegrass B @ Hannah Roethle

Class Description

We begin with an in-depth review of the Address and Individual Records, including the
membership records screens and fields, their features, and toolbars. The relationship between
Address Records, Individual Records, and Giving Unit records is explained. This class is an
effective introduction to Membership, providing the beginning user everything needed to get
started.

Class Topics

How To Use An Address Record

¢ Family Records - Family Information
> Photos
« Assigning Families for Care
« Giving Unit Assignment
« Pastoral Care
« Connected Records
+ Adding a New Record
o How to Enter Couples with Different Last Names

How To Use Individual Records

+ Personal/Membership Information
» Groups

» Visitation Information

» Attendance Information

« When an Individual Moves

« Adding a New Individual
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Membership Data Management

A Mon 11:15 - 12:30 | Bluegrass B @® Don Howell
35 Tue 35 - 4:30 | Bluegrass B @ Hannah Roethle

Class Description

Learn to customize CDM+ Membership with an in- depth look at the Master Coding System and

how to best set up Membership to support the ministries of your church. Learn how to use List

Maintenance, Field Maintenance, and list transfer to manage groups and personal data.

Discover the expansive possibilities the User Fields offer you to track a wide variety of family and

personal information. This class will focus on cleaning up Membership records and maintaining

them on an ongoing basis.

Class Topics

Master Coding System

» Codes

» Groups
o Detailed Tracking
o Attendance
o Ranked

» User Fields

Membership Maintenance

« Address/Individual Field Maintenance
« Address/Individual List Maintenance

Address Utilities
« Update Grades

Membership and Attendance Preferences
 Fields
» Default
* Notices

User Specific Preferences

* Visitation
» Pastoral
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Membership Reports

LKA Mon 1:45 - 3:00 | Bluegrass B
Wed 8:15 - 9:30 | Bluegrass B

Class Description

@® Don Howell
@ Hannah Roethle

Discover the many membership reports you can create using CDM+ and its multiple configurations.

Learn how to create Yearbook Directories and Name Badges for your members or staff to use. Discover
the strengths of the Custom Listing reports and how they enhance your capacity to view your data. We
will review how to export data from CDM+ to other programs and how to manage simple and complex

queries. Join us as we look at how CDM+ Membership Reports can enrich your effectiveness and your

productivity.

Class Topics

Directories

» Address

* Individual

» Address Yearbook

* Individual Yearbook

Labels/Envelopes

« Address
« Individual

Notices

» Letters
« Cards

» Saving Sent Notices in Preferences

 Emails

Custom Listing and Exports

« Address
» Individual

Name Badges

« Address
» Individual

Summaries

« Address
» Individual
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Getting Started Attendance

@ Tue 1:45 - 3:00 | Barrel Room 6 Don Howell

Class Description

Learn how to enter event, class, and list attendance for worship services, Sunday School, small
groups, and even board meetings! Putting individuals in classes or groups, as well as preparing
attendance worksheets (barcoded and not), is taught. See how easy it is to take live attendance
with the CDM+ Mobile app, easily accomplish Class promotion, and create Attendance Histories.

In order to begin tracking attendance in CDM+, you must have the following items in place:

* Individual Records must be entered.

+ Master Codes for Services/Events, Church (Sunday) School Classes, and other groups or lists
must be identified and entered.

« Membership Status codes should be set up for control of Attendance Lists.

Class Topics

Setting up Class and Group Lists
Assign Individuals to Classes

Attendance Preferences

Taking Attendance

« Attendance Worksheet By Date

« Attendance Worksheet

Barcode Worksheet

Entering Attendance for a Service or Event
Entering Attendance for a Class

> Using a Barcode Reader to Enter Attendance

Setting Up Attendance Taking on a Tablet or Phone

« Set Up Attendance Taking - tablet app

« Set Up Attendance Taking - phone app

« Using CDM+ Mobile to Enter Attendance
- Barcode Attendance App

Update Attendance History and View

Attendance Promotion

* Individual List Maintenance
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Attendance Analysis & Reports

@ Tue 3:15 - 4:30 | Barrel Room 6 Don Howell

Class Description

Attendance tracking accomplishes little without attendance analysis! Vital individual and group
analysis is demonstrated by using the Missing Analysis report and the Attendance by Date
report. Learn how to view a full year's attendance summary for an individual. Exporting
attendance records and event statistics are examined. Master accessing and analyzing the
significant individual and group attendance data tracked in CDM+,

Class Topics

Attendance Reports

« Attendance Directory

« Attendance By Date
Attendance By Individual
Attendance Summary

« Missing Analysis

Notices

« Letter Notices
« Card Notices
« Email Notices

Attendance Export

Event Statistics
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Visitor Tracking

Wed 8:15 - 9:30 | Barrel Room 6 Don Howell

Class Description

Growing churches know who's visiting and follow a process to minister to and assimilate visitors
into their fellowship. This class demonstrates a process and presents you with the tools through

the Membership/Attendance and Contributions programs to implement an effective procedure
for ministering to visitors and prospects.

Class Topics

Visitor Records

» User Defined Groups

+ Follow-Up Ministry/Outreach Actions
« Additional Phones/E-mails

» Individual Attendance

« Comments

Attendance Tracking of Visitors

« Entering Attendance for a Service or Event
« Entering Attendance for a Class

Visitor Letters

« Create Visitor Letters
» Print Visitor Letters

Demographic Information and Follow-up of Visitors
Connections

Reports and Analysis of Effective Evangelism
* Visitor Master Listing
* Measuring Effectiveness of Visitor Follow-Ups
« Analysis of Effective Evangelism
« Tracking Where Your Visitors Are Coming From

Using Membership Records for Visitors
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Contact Management

@ Tue 11:15 - 12:30 | Bluegrass B & Dean Phelps

Class Description

Faith-based and other non-profit organizations are in the people business. Building trust
through regular contact and timely follow-up remains a high priority. Visitation and Pastoral
records in the CDM+ Membership program provides an effective means of tracking contact
with people connected to your organization.

In this class, we will learn how to use the CDM+ Mobile app and the CDM+ desktop program to
record contacts, create reminders, and push reminders to CDM+ Mobile devices. We'll also learn

how to secure visitation and pastoral information to ensure that confidential information
remains confidential.

Class Topics

Visitation and Pastoral Records

o Data Privacy
o Granting Record Access to Users
o Connecting Mobile Devices to Visitation Records

Setting Up Notifications to Mobile Devices
Setting Default Access to Visitation and Pastoral Records

Creating Visitation Records and Reminders in the Desktop
Creating Visitation Records and Reminders in CDM+ Mobile

Create Pastoral Records in CDM+ Mobile

2025 CDM+ Users Conference Contact Management 7-1



Notes

7-2  Contact Management 2025 CDM+ Users Conference



Getting Started Contributions

A Mon 9:45 - 11:00 | Rockbridge Reserve [ Roslyn Brittain
i) Tue 315- 430 | Barn o

Class Description

Here, we cover everything you need to begin entering contributions, including setting up Giving
Codes and Giving Funds, viewing individual Giving History (both in CDM+ Contributions and
CDM+ Mobile), and the Groups field on Giving Unit records. Basic Batch Contributions setup
and entry is explained. Everything you need to know about linking to Accounting and Posting
to Accounting is explained. Learn to verify your contributions entry through the use of Daily
reports.

Class Topics

Giving Unit Records

» Creating Giving Unit Records
o Creating a new Address Record, and adding a Giving Unit Record initially
o Adding a Giving Unit Record to an existing Address Record

» Path to Giving Unit Records
o GO buttons

 Display Information Talbs

Contribution Setup

e Link to Accounting
e Link to Memorial Gifts

Giving Funds

* Importance of Sort Order
* Inactive

» Non Tax-Deductible

e Sets

Contribution Entry

« Batch Contribution Entry

o Preferences
o Batch Setup
o Entering Contributions

» Loose Offerings

= Non Tax-Deductible Contributions
o Contribution Records

= Gifts In-Kind

= Do Not Post to Ledger
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Post Contributions

Contribution Reports

 Daily Contribution Report

¢ Check Deposit Report

 Daily Contribution Breakdown
« Contribution Worksheet

8-2  Getting Started Contributions
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Contribution Procedures

A Mon 11:15 - 12:30 | Rockbridge Reserve

[ e
@ Wed 8:15 - 9:30 | Barn o Roslyn Brittain

Class Description

Go beyond the basic Contributions Entry and the Daily Report of Giving . Maintaining the integrity of the
Contributions History file is covered, as well as demonstrating its printing capabilities . The use and set up of
“Special” and "Visitor” giving codes to track loose cash and visitor gifts are explained . If you receive regular
checks or electronic fund transfers that are generated by givers' banks, you'll also learn how to streamline
entering those in your contributions records . Information about handling special offerings, gifts-in-kind, and
non-deductible gifts is given . Tracking and reporting of Memorial Gifts is also covered.

Class Topics

Linking Contributions to Accounting

Giving Funds

» Creating Giving Funds
» Creating Giving Sets
« Non Tax-Deductable Gifts

Giving Unit Codes

» Loose Offering Giving Code
« Visitor Giving Code
« Updating Giving Unit

Recording Contributions

« Batch Contribution Entry
o Special Offerings
o Gifts-in-Kind
> Mass Contribution Edit
« Contribution Records
> Used for other payment processors besides Engage Giving
o Used for returned deposit items

Memorial Gifts

+ Activating Memorial Gifts/Contribution Link
o Recording Memorial Gifts as contributions
o Recording Memorial Gifts not as contributions
o Using Memorial Gifts
o Memorial Gift Reports
» Reporting Gifts to the Designee’s Family
= Memorial Gifts Given Report
= Memorial Gifts Used Report
= Memorial Gift Labels
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Class Topics Cont.

Contribution Procedures

» Transferring Contributions between Giving Units
o Transferring vs. Merging Giving Unit Records

o Transferring Contributions from a Visitor Giving Unit Record
¢ Giving Unit Email Maintenance

Contribution History

« Creating/Updating Contribution History
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Contribution Statements

@ Mon 1:45 - 3:00 | Rockbridge Reserve

® e
Wed 9:45 - 11:00 | Barn @ Roslyn Brittain

Class Description

Accurate and timely Giving Statements promote good stewardship by members and
donors. This class reviews the Contribution Statement report options built into CDM+ so you
can decide which is best for your church . This one class covers the creation of, paper,
emailed, and online Giving Statement reports. Using contribution Receipts is also covered.

If you have the responsibility to prepare Giving Statements, don't miss this class!

Class Topics

Contribution Statement Options

» Contribution Statements

» Contribution Statements Email

» Contribution Statements Line

» Contribution Statements Line Email
* Online Giving Statements

« Contribution Receipts

Configuring Contribution Statements

Formatting Options

» Close look at Configuring Ranges
« Email Statement Setup
o Giving Unit Email Maintenance
> Notices (Training on Notices will be offered in a separate class)

Online Statements

* Preparation
- Generate a Batch
« Reviewing the Statements
« Publishing the Statements
« Email Published Statements
« Retracting Statements
« Viewing and Downloading Statements
o How to see if a Donor has Viewed their Statement
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Contributions Pledging

@ Tue 9:45 - 11:00 | Barn & Roslyn Brittain

Class Description

Churches often use the pledging process as a financial forecasting tool. Learn how to enter
annual pledges and use the Multi-Year Pledge function. Learn what “projected” pledges are and
how they are integrated into the reporting process. Pledge comparison reports are reviewed

and the process of creating a Letter Notice with a member's actual Pledge Amount included is
demonstrated in this class.

Class Topics

Pledge Preferences
* Terms

Giving Funds
* Importance of separate Giving Fund for each Pledge Year
Pledges

« Establishing Pledge Funds/Pledge Setup
» Entering Pledges
o Actual vs. Projected
o |nitial Amount
° Frequency
+ Pledge Changes/Cancellations
Pledge Reports
« Pledge Listing
« Pledge Letter Notice
» Pledge Comparison

o Actual vs. Pledge
> Pledge by Month
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Contribution Comparison Reports

Wed 1115 - 12:30 | Barn & Roslyn Brittain

Class Description

In this session, we review many of the reports within Contributions. Comparative reports and
exports are investigated. Learn how to create Contributions letters to givers that include their

Year-to-Date giving totals right in the text of the letter! Listing reports, including Giving Detail by
fund(s) and Giving by Date, are effective evaluation tools for stewardship committees. Analysis of
giving by dollar ranges and increase/decrease in giving by individuals or giving to specific Giving

Funds is taught.

Class Topics

Contribution Reports

+ Labels/Envelopes
* Notices

* Statements

* Receipts

Daily Reports

« Daily Report of Contributions
 Daily Contribution Breakdown
» Check Deposit Reports

Listing and Exports

« Giving Unit Listing

« Contribution Worksheet

Detail Contributions

Contribution Totals by Date

Contribution Custom Listings and Export
Pledge Summary Custom Listing and Export

Notices
« Contribution Letters

Comparative

« Composite by Giver vs Composite by Date
« Totals By Month

« Contribution Range

« History Comparison

Engage

« Transaction Custom Listing and Export
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Engage Online Giving
and Online Payment Processing

A Tue 11:15 - 12:30 | Rockbridge Reserve

[ ] . .
E Tue 3:15 - 4:30 | Rockbridge Reserve [ ] Julianne Manning

Class Description

Online giving and payment options are plentiful, but only one solution — Engage Giving with
Payment Processing — automatically enters donations and payments into CDM+ Contributions
and CDM+ Fund Accounting! Learn how to set up Engage Giving to allow easy, secure one-time
and recurring online giving via debit card, credit card, or ACH bank account transactions. Find
out how to organize funds using giving sets, and how to handle gift notifications, confirmation
emails, processing fees, and more. Plus, we will discuss how to track these online gifts, event
registrations, and payments from receipt to positing to the ledger.

Our unique Deposit Processing tool automatically reconciles electronic deposits made into your
bank account and creates ledger entries that track the income and fees associated with these
transactions. Learn how to track the status of payments, including failures and returns, and how
to issue refunds.

Class Topics

Engage Giving
* Engage URL
« Memo
» Staff Notifications
» Fee Assist
» Guest Gifts

How to Create a Giving Set

*« Naming the Set

» Customizing your URL

« Ways to Publish your Link

Adding Funds

Enabling Recurring Payments

Allowed Payment Methods

« Customizing the Look and Feel of your Link

How to Give through Engage

 New Members
» Give as a Guest
« Make a Donation
o Give Anonymously
» How To Give By Signing In
> Manage Recurring Donations
o See Online Statements
o Update Payment Method
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Administering CDM+ Engage Giving (Giving Unit Records)

» Scheduled Gifts

« New Gifts

+ Payment Methods
» Recent Gifts

Online Payment Processing
Permissions
Setting Up Accounts For Income and Fees

« Contributions
« Event Records
* Engage Billing

Process Pending Contributions
Event Registration Payments
Deposit Processing

» Mark For Processing
» Red Dots
» Post
» Toggle Already Marked For Processing Button
» History
o Print
> Show Records
o Unprocessed
* Online Deposits

Payment Administration

« Search Transactions
o Details
o Scheduled Gift
° Issuing a Refund

How To See Expiring Cards
One-Time Charge
Bonus Materials

« Transaction Custom Listing Report
« Text to Give
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Grow Your Giving

Wed 8:15 - 9:30 | Rockbridge Reserve a Julianne Manning

Class Description

CDM+ allows you to turn your data from your database into a powerful fundraising tool. Whether
you're raising money for a capital campaign, mission trip, or just want to find ways to increase
your weekly Tithes and Offerings, CDM+ provides specific tools to increase your giving. In this
class, we'll focus on ways you can pull different reports to see live data on your givers, customize
your giving links, and provide marketing tips and tricks on how you can publish your links. We'll
also hear from other users on ways they successfully use their giving links.

Class Topics

Defining Your Donor

* Recurring Givers

* Major Givers

» Special Interest Givers
e Lapsed Donors

Customizing Your Giving Sets

« Determine how many funds to add to a set and when to use them
« How to continue your branding for your purpose

Marketing Tips and Tricks

« Ways to Publish Your Links

« Where to Put Your Link On Your Website

+ How to Encourage Members to Use Online Giving
« Contribution Notices

¢ Current Giving Trends

User Experience

« Hear from each other on specific ways you have used your giving links
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Getting Started Accounting

A Mon 9:45 - 11:00 | Bluegrass A [ ) Jennifer Nelson
£ Tue 115 -12:30 | BluegrassA @B

Class Description

In this class, we cover the basics of CDM+ Accounting beginning with the Accounting Setup
Window and moving through the Chart of Accounts to the General Ledger. Participants receive
a solid "how-to" introduction to Accounting Beginning Balances and Ledger entries. Deposits
and Journal entries are also explained.

This class also covers an introduction to double-entry accounting including Account Types,
Debits and Credits, Funds, Fund Accounting, and the relationship of Ledger Entries to
Income/Expense and the Balance Sheet reports.

Class Topics

Accounting Basics

* Balance Sheet

* What is Fund Accounting
* Account Types

* Fund Balance Accounts

* Double Entry

Setting Up Your Chart of Accounts

Think with the end in mind
+ Categories/Sub-Categories
« Balance Sheet Accounts

Income/Expense Accounts

L]

L]

Accounting Setup

* Beginning Balance Window
o Purpose of it
o Keeping it in balance

¢ Formatting Checks

* Check Numbers
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General Ledger A &B

Mon 11:15 - 12:30 | Gen Ledger A | Bluegrass A
A Mon 1:45 - 3:00 | Gen Ledger B | Bluegrass A
@ Tue 1:45 - 3:00 | Gen Ledger A | Bluegrass A

Tue 3:15 - 4:30 | Gen Ledger B | Bluegrass A

& Jennifer Nelson

Class Description

This class takes the next step in CDM+ Accounting and delves deeper into ledger entries,

budget, bank reconciliation, period closing procedures, and Advance Fund Accounting. Learn

how to save time by using Ledger recurring transactions for month-end transactions and

check-writing. Emphasis is also given to troubleshooting issues such as finding and correcting
ledger mistakes, and understanding the relationship between Contributions, Accounts Payable,

and Payroll.

The General Ledger class is one class spread over two class periods repeated two times.
Participants should plan to take the same Part A & Part B together.

Class Topics
Ledger Entry Records Window

« What is the Ledger Entry Records window and what is it's function
« How to Navigate the Window
« Entering different types of Transactions into the Ledger

o Check

o Entry

o Deposit

Recurring Ledger Entries

» Set Up Entries
e Creating Recurring Entries from Setup

Voiding and Deleting Ledger Entries

« Offsetting Entry
« Zeroing Out Entry

How To Search In The Ledger Entry Record Window
» Find
+ Advanced Find
» Searches On the Side

Budget

Creating a New Blank One
Copying From a Prior Budget
Adding Accounts

Budget Inspector

Budget Window Features

L]

L]

L]

L]

L]
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Class Topics Cont.

Helpful Ledger and Budget Reports

Bank Reconciliation
+ Adding a New Month
» Clearing Entries
« Showing and Clearing Voids

Close/Open Periods

« Closing a Month
* What Happens When You Close
« Opening a Month

Closing A Year

16-2 General Ledger A & B

2025 CDM+ Users Conference



Notes

2025 CDM+ Users Conference General Ledger A & B 16-3



Notes

16-4 General Ledger A &B 2025 CDM+ Users Conference



Accounts Payable

A Tye 9:45 - 11:00 | Bluegrass A ® Jennifer Nelson
Ei) Wed 9:45 - 11:00 | BluegrassA @@

Class Description

This session covers the Accounts Payable process. Vendor setup and reports, including 1099
vendors will be presented. Creating recurring and non-recurring invoices, the use of Mobile
Receipts and the use of invoice reports is demonstrated.

We help you understand the purpose and function of accrual accounting and how easy it is in
CDM+. This class also covers how to select invoices for printing, check printing, and re-printing, if
necessary. The Post to Ledger option and posting reports is detailed.

Class Topics

Creating a Vendor

« How to Inactivate a Vendor

« Miscellaneous Vendors

« Creating 1099 Vendor and Marking Payments as 1099 Items
« Creating Credit Card Vendor

Entering Purchase Orders

Entering Invoices
« Entering Credit Card Purchases

Marking Invoices to Be Paid

» Check
 Auto-Draw
» Credit Card

Printing Checks and Posting Payables to the Ledger

Create Recurring Transaction Invoices
Ledger by Vendor Report
* 1099 Vendors Only

+ How to Select Specific Vendors

Mobile Receipts
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Accounting Reports

A Mon 3:15 - 4:30 | Bluegrass A [ ) Jennifer Nelson
i) Wwed 1115 - 12:30 | Bluegrass A (]

Class Description

This class will go over all the Accounting reports in CDM+, the different features found in ledger
daily/week work reports, budget reports, and month-end reports. This class covers an in-depth review of
ledger reports, including Monthly Comparison, Monthly Summary, Range Summary, Ledger by Accounts,
Accounting Balances-Balance Sheet, Trial Balance, and Fund Activity. Using reports as troubleshooting
tools is also demonstrated.

Class Topics

How to Generate Reports and Use Reports for Troubleshooting

Creating Account Sets
Using the Account Browser to Select Reports

Activity Reports
Balance Reports

Comparison Reports
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Accounts Receivable

Wed 8:15 - 9:30 | Bluegrass A 6 Jennifer Nelson

Class Description

The Accounts Receivable area of CDM+ Accounting is a valuable tool for any type of
invoice/billing needs; i.e.,, churches with a school or day care center. This class reviews all aspects
of Accounts Receivable. See how easy it is to keep track of money owed to your organization
and to present professional invoices/statements. We will also cover Engage Billing which allows
customers to see their balance and make online payments.

Class Topics

Setting Up Account Numbers in Accounting
Customers

« Creating New Customers
« Setting up Recurring Invoices
» Linking Individuals for Online Engage Payments

Accounts Receivable Invoices
« Creating New Invoices
« Creating Recurring Invoices
« Accruing Invoices
Payments
» Creating New Payments
+ Posting Payments
Engage Billing
» Seeing Invoices
« Payments
Statements

« Generating a Statement
* Printing Statements

Accounts Receivable Reports
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Getting Started Payroll

A Tye 9:45 - 11:00 | Barrel Room
@ Wed 9:45 - 11:00 | Barrel Room

Class Description

Don Howell

Proper payroll setup and payroll procedures are the goals of this class. You will learn time saving
steps to assist with adding new employees. Participants also receive an in-depth understanding
of exactly how CDM+ calculates payroll, writes checks, posts to the ledger, and can be viewed in

Engage Payroll. The relationship of CDM+ Payroll with Accounts Payable and the General
Ledger is presented. This class is for both the new or experienced user of CDM+ Payroll.

Class Topics
Setting Up Payroll

e Chart of Accounts
« Payroll Defaults

« Deductions

« Payer Records

Employee Information

« W-4

+ Pay ltems

« Time Off
Liabilities

* Engage Payroll

Calculating Payroll

» Salary
* Hourly
e Time Off

Writing Payroll Checks/Direct Deposit/ACH

« Writing A Payroll Check
» Direct Deposit Payroll

o Set Up Employee Account Information

o Employee Selection

o Processing Payroll for Direct Deposit Payroll

« ACH Payroll Deposit
o ACH Setup
o General Section

o Immediate Destination/Immediate Origin

o Export File Defaults

o Set Up Employee Information

o Employee Selection

o Processing Payroll for ACH Deposit

o Create ACH File
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Payroll Procedures & Reports

A Tye 11:15 - 12:30 | Barrel Room ® Don Howell
Ei5) Wwed 11115 - 12:30 | Barrel Room @@

Class Description

The focus of this class is to understand the inner workings of CDM+ Payroll to help deal with
situations that you may encounter. We will look at the process of voiding a payroll, reissuing a
payroll check, correcting payroll not set up correctly, validating 941 and W-2 information, and
verifying balance sheet payroll liabilities. An overview of the optional ACH direct payroll deposit
payroll process will be presented. If time permits we will take an in-depth look at using the
features in payroll to track employee sick, vacation, and comp time.

Class Topics

Voiding a Payroll
* Reissuing a Payroll Check

Correcting Taxable or W-2 Information Not Set Up Correctly
Validating 941 and W-2 Information
Verifying Balance Sheet Payroll Liabilities

» User Deductions

Aatrix and Payroll Tax Forms

e Tax Forms Payer Information
» Using Aatrix Tax Forms

» Continuous Updates

* 941 Form

W-2/W-3 Forms

» State Forms

Sick, Vacation, and Comp Time
« Calculating Time Off

Payroll Reports
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Aatrix Tax Reporting

@ Tue 1:45 - 3:00 | Barn & Roslyn Brittain

Class Description

CDM+ partners with a third party provider, Aatrix, to produce all State and Federal Forms.
Information from CDM+ payroll is passed onto the Aatrix Form Viewer. Corrections to tax
forms can be done through the Aatrix Form Viewer, but it is highly recommended that all
corrections be made in CDM+. This class will prepare you to produce an accurate 941, W-2 and
1099 forms.

Class Topics

Aatrix Forms Viewer

* Printing Tax Forms

- Both Federal and State Reports are available
» How to Select the Reports

» Aatrix Form Viewer Installation & Setup
 Validate Information in Wizard

941 Reporting

» Use the Taxable Income Summary Report, with the Date Paid Option, to validate
Information on the 941 are correct

+ How to Produce the Form

« Best Practice on How to Make Changes if Necessary

* Print Form or File Electronically

W-2 Reporting
» Validate the information on the Payer record
» Use the Taxable Income Summary Report, with the Date Paid Option, to validate
Information on the W-2 forms
» How to Produce the Form

» Best Practice on How to Make Changes if Necessary
* Print Form or File Electronically

1099 Reporting

« Use the Ledger by Vendor Report to determine what Vendors needs to receive a 1099
¢ How to mark missing payments to be Included on the 1099

« How to Produce the Form

» Best Practice on How to Make Changes if Necessary

e Print Form or File Electronically

History

» How to Find Previously Filed Reports
» View Historical Reports
» Reports are saved on the computer where the report was generated
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Roommate Facilities Manager

Mon 9:45 - 11:00 | Barn 6 Julianne Manning

Class Description

Roommate is your solution for facilities scheduling. Here we present in detail how to use CDM+
Roommate to track your events, rooms equipment, whether on campus or off.

Discover other uses of this powerful tool in scheduling staff, categorizing events by Department,
and keeping an up-to date inventory of your organization’s assets. We will also cover how to use
Web Ministry Tool to publish your calendars online.

Class Topics

What Is Roommate?

CDM+ Roommate combines an event calendar, resource and contact manager
into one easy-to-use, powerful program.

Uses For Roommate

» Event Calendar

Staff Schedules

» Volunteer Schedules
Resource/Inventory Management
Facility Management

Roommate Master Coding System Options

 Room Configurations
* Departments

* Resource Types

« Roommate User fields

The Different Records of Roommate

« Room records
o Room Details
o Configurations
o Resources
o Connections
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The Different Records of Roommate (cont.)

» Resource Records
o Resource Details
o Default Locations
o User Fields
o Connections

« Contact Records
o Contact Details
o Connections

System Preferences
* Managing Conflicts

User Preferences

* Sch. Formats
« Room Sort
Schedule
Monthly Cal.
+ Event Sort

Events Schedule

* Monthly, Weekly, and Daily Views
 Filtering by Department

 Filtering by Room

« Navigating Options
« Saving Views

* Event Inspector

Creating An Event

« Event Details
« Rooms

* Billing

* Notes

» Resources

* Recur Event

> Standard and Advanced Options
o Adding or Skipping a Date
o Deleting a Recurring Event

« Conflicts
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Publishing Your Calendar Online

* How to Login to Web Ministry Tools

« How to tie Web Ministry Tools to Roommate

* How to Publish the Department and Rooms that you want
* How to Publish Your Calendar to your Website

Roommate Reports

* Monthly Calendar
« Event Custom Listing and Export Report Options
* Resource Reports
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Event Registration A &B

@ (A) Mon 11:15 - 12:30 | Barn

P : :
(B) Mon 1:45 - 3:00 | Barn @@ Julianne Manning

Class Description

This is a two-part class that will cover both the setup of an Event and how to utilize tools to
manage your event. In Part A we will walk through the steps to create an event record, structure
custom activities, setup confirmation emails, create an online registration option through Web
Ministry Tools, and record manual registrations. We will also highlight how to tie event
payments and fees to CDM+ Fund Accounting and how you can see historical event
registrations for members in CDM+ Membership. In Part B we will explore the tools to help
Mmake your event a success. In this class we will focus on what to do with all of your online and
manually entered registrations. From our robust reporting system to creating name badges to
sending out follow-up emails and letters we will walk through these features that will help you
manage your event like a pro!

Class Topics

Creating An Event Record

« Adding Event Details
* How to Add Activities
« Adding Connections

Event Notices

+ How to Navigate to Event Notices
+ Ways to use Event Notices
» How to Set up a Search to Send Notices

Connecting an Event Record to Web Ministry Tools

* How to Login to Web Ministry Tools
» Creating and Connecting an Event
« Previewing and Publishing your Event Link

Registration Entry

* Engage Registrations
* Manual Registrations
o Registrants
Contacts
User Fields
Activities
Payments
Sent Notices
Post Payments to Ledger
« Adding New Payments for an Event
o Through Engage
o Through CDM+

o

o

o

o

o

o
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Viewing Historical Event Registration for Members

* Individual Records
o Connections

Event Reports
« Master List
« Master List Detail
+ Payments
« Activity
« Custom Listing

Names Badges
Labels/Envelopes
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Check-In/Check-Out

Wed 11:15 - 12:30 | Rockbridge Reserve 6 Julianne Manning

Class Description

CDM+ Check-In/Check-Out is a versatile addition to the CDM+ suite that tracks everything from
childcare to youth groups, adult classes, and more. This class covers every main window in the
Check-In/Check-Out program including setup, performing check-ins and check-outs, and
running reports. We also discuss how to configure Check-In/Check-Out for a broad range of
events, from security-conscience childcare to automatic attendance entry using self-check-in,
including using the CDM+ Mobile app.

Class Topics

Check-In/Check-Out Event Record

« Event Tab

» Check-In Reports
» Validation Fields
* Notes

» Connections

Check-In/Check-Out Event Sets

« How to add Events to an Event Set
* When to use an Event Set

Self (Manual) Check-In

« Self Check-In Process
» Check-In Reports

Staff Check-In

 Staff Check-In Process
¢ Check-In Reports
* Viewing an Individual Record
e Troubleshooting
o Re-printing name badges

Barcode Check-In

Mobile Check-In

« Tablets

« Phones

« Check-In Process

« Printing Name Badges
Mobile Check-Out

« Different Check-Out Scenarios
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Check-In/ Check-Out Child Care Options

* Pre-Authorization

» Check-In Name Badges and Receipts
+ Adding Notes

* Manual Check-Out

¢ Check-Out Using a Barcode

» Checking Pre-Authorization

Reports

« Utilizing Membership Reports
« Check-In/Check-Out Report Options
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Administering CDM+

Mon 3:15 - 4:30 | Barn 6 Don Howell

Class Description

Get familiar with the essential CDM+ administrative features. We'll discuss best practices for

mManaging user's permission and review systems and user preferences to get the most of CDM+.

Using the Audit log to review detailed record changes will also be covered.

Class Topics

CDM+ Structure

+ CDM+ Desktop
o Primary platform for managing CDM+ data
o Download from Suran Help Center
o Contains windows, reports, and program logic
+ CDM+ Engage and Web Ministry Tools
o Web-based access to your data
o Member's portal
> Online Giving
o Registrations
« CDM+ Mobile
o Data access from a mobile device
o Download from the App Store/Google Play/Amazon
« CDM+ Hosting
o Service managed and provided by Suran
o Hosted in data centers around the US and internationally
o Manages backups, including separate off-site backups
o Communicates between CDM+ Desktop, Engage, WMT, Mobile, and your data
o Also contains certain server-based functions for CDM+
« Database
Main Database or Archive
o Contains all your information
o Service managed and provided by Suran
o Hosted in data centers around the US and internationally
o Manages backups, including separate off-site backups
o Communicates between CDM+ Desktop, Engage, WMT, Mobile, and your data
Also contains certain server-based functions for CDM+

o

o

Maintenance

« Consistent data entry (see Archiving & Data Cleanup Manual)
« Security
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Installing CDM+

¢ Installing on a Mac
¢ Installing on a Windows machine

Connecting to Your Account

Logging in to CDM+

» Alternate Login Method
» User Login
» Passwords

Administration

+ Access/ Audit Log
« Permissions

» Mobile Profiles

+ Updates

« Payroll

e Sets

» Searches

« Notices

* Encryption

Preferences

» User Preferences

o Toolbars

o Defaults

o User Email

o Enter Key Function
» System Preferences

o Name

o Terms

o System Email

Suran Support

« Opening a Support Ticket
« Opening a Training Ticket
« Opening a Customer Service Ticket
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Engage Administration

@ Tue 9:45 - 11:00 | Rockbridge Reserve

@ . .
Tue 1:45 - 3:00 | Rockbridge Reserve [ ) Julianne Manning

Class Description

Bring fresh, enriching content to your organization's website and know that any information

you publish there is updated whenever you make changes in CDM+. This class walks you
through setting up CDM+ Engage, managing Engage user accounts, and publishing Engage to

your members, supporters, and visitors. How to work with Web Ministry Tools is included, as is
granting access to staff to manage just the right areas of Engage. If you administer Online

Giving, Directories, Payroll, or Events, this class is strongly recommended for you!

Class Topics

What Is Engage?
What Can You Do With Engage?

Getting Started

* No Additional Cost with Any SAAS or Cloud Plan
¢ Merchant Account If Using Engage Giving
« Assigned a Unique URL You Can Use

Used Permission
+ How to Create Engage Administrators
Engage Settings

« Organization
« Member Changes
« Publish Engage

Organization Directory
Logging Into Engage

« Creating An Account
« Matching Email Address
« Email Address Not Found
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Engage Privacy Settings
» Profile Settings
» Profile Preview

Managing Engage Credentials (Individual Record)

« Change, Clear, and Transfer an Individual's Engage settings
* Engage Roles

o Standard

o Administrator

Processing New Accounts

Merging Accounts

Accessing Engage on a User's Behalf
Web Ministry Tools

» Creating a Tool
» Options

« Publish

« Church Profile
* Users
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CDM+ Mobile

D Tue 9:45 - 11:00 | Bluegrass B [ )
i) Wed 1115-12:30 | Bluegrass B~ @ D" Phelps

Class Description

People serving in faith-based or other non-profit organizations are not stationary. They need

data that is on the move with them. In this class, we will learn how the CDM+ Mobile app keeps
you connected to CDM+ from your iOS or Android mobile device. We will learn how to use
CDM+ Mobile to work with people, attendance, visitation contacts, and charge receipts.

Class Topics

Connecting a Device to Your Database

» Setting up a Device
» Transferring Settings to a New Device
» Disabling a Device

CDM+ Mobile Applications

« Applications for most CDM+ programs
» Setting up Access to Applications

Staying in Touch with People by Email and Text

» Setting up Mobile Uses for Email and Text Messages
« Contacting Individuals
« Contacting Groups

Getting Reminders
» Using the Reminders app

Recording Attendance

« Record Attendance Manually
« Setting up Barcode Attendance
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Searches/Custom Listings

A Mon 3:15 - 4:30 | Bluegrass B ®
i) Wed 9:45-11:00 | BluegrassB @ DS2n Phelps

Class Description

At its core, CDM+ is both a database of people and an accounting database. People relate to

your organization in a variety of ways. For example, people are related to one another in
households. They donate to your organization. They register for and attend events. Likewise, an

accounting database is more than journal entries for income and expenses, Journal entries
relate to donations as well as to customers and vendors. Those database relationships make

CDM+ a robust and powerful database. In this class, we will explore how to harness that power
by learning how to search the data so that we can produce reports or export data.

Class Topics

Custom Listings and Exports: Rows and Columns of Data

Begin with the End in Mind

» Desired Columns Point to the Primary Record Type
» Desired Rows Dictate the Search Criteria

Using the Record Window to Search

« Simple Finds with a Single Criteria
« Advanced Finds with Multiple Criteria

Advanced Searches Using Related Records

Building Your Custom Listing and Export

» Using Reports from the Sidebar Button
» Using Reports from the Menu Bar

Saving Your Searches
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Notices

@ Mon 3:15 - 4:30 | Barrel Room (]

; Y Julianne Manning
Wed 9:45 - 11:00 | Rockbridge Reserve

Class Description

Want to save yourself the extra steps of exporting email addresses or creating merged letters?
This class covers how to use the word-processor-like features of Notices in CDM+. You can create
eye-catching, personalized cards, letters, and emails from within CDM+. We also cover

organizing notices by category and set access to saved notices. Put the power of CDM+ to work
in your communications!

Class Topics

Professional Communications
Notices For Different Parts Of The Program

Features of Notices

+ Letters

« Cards

* Email

» Pull in Database fields

« Continuation of your branding

Organizing Notices

« Navigation

+ Select/Add

« Add/Edit/Duplicate/Delete

« Adding and Duplicating you're prompted to provide a name

Setting Access
* View
* Modify
Categories

» Optional
e On-the-Fly and MCS
« Assigning a Category to New and Old Notices

Formatting/Editing Notices

« Formatting Palette
» Insert Options

» Find and Replace

« Custom Dictionary
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Delivering, Tracking, and Resending Notices

» How to Print or Send a Notice

» How to View the last time a Notice was Sent

+ How to see Sent Notices from Address/Individual/Giving Unit Notice tab
» Individual Sent Notice Record window

» Re-send a Notice
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Archiving & Data Cleanup

A Mon 3:15 - 4:30 | Rockbridge Reserve

® L
B Tue M5 - 12:30 | Barn @ Roslyn Brittain

Class Description

Confused about archiving? Learn the purpose and benefits of archiving and tips and techniques
for cleaning up your data. This class teaches not only how to archive CDM+ data, but when and
what data to archive. Tools to make bulk updates and corrections are also covered, as are best
practices for standardizing your data to improve reporting and data analysis.

Class Topics

What Is Archiving and Why Do it?

« Archiving moves some information out of your main database into a separate database
* It is used to section off historical information while keeping it readily available
* Itis part of a control process for your database, much like closing an accounting year or
filing giving history
» Three Options of Archiving Ranked
o Standard Archive
o Copy Only
o Delete Only (we recommend to have Support assist you with this option)

Program Organization
« Understanding the Parent/Child relationship when archiving

Archiving Considerations

« One Archive database should be used to Archive all of your CDM+ data
» Timing

> Most often done at the end of the year
« Leave the most recent 3 -5 years of data in the main database

Preparation Steps

Special Considerations Before Archiving

+ Attendance - Run the Update Attendance History Function
» Contributions - Processing Pending Contribution records, prior to running the
Update Contribution History Function

Address Records
« Use Mailing Codes: Pending Archive, Ready to Arching
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Individual Records

* Individual marked as Inactive
 Membership Status: Deceased
» Death Date

Ledger Entry Records

We strongly encourage to have a Support Specialist assist you in

preparing your data, prior to archiving.

« Process Online Deposits

e Close all months and years

« Be certain that all ledger items have been cleared on bank
reconciliation statements for the period to be archived

 If there are any offsetting voided entries, check that both sides of the
voided entries are in the records to be archived

Archive Process

« Back up your active CDM+ database

« Decide whether to create a New Archive or to Archive to Existing file
o New Archive - Put “Archive” in Name

« Select which records to archive
o Archive records selected by an Advanced Find

« Check the archive preview and settings

» Proceed to Archive records

Accessing Archive

+ How to login to the Archive database
+ User Management and Login

Restoring Data from an Archive Database

« Select records to restore through the Advanced Find
« Check the archive preview and settings
» Proceed to restore records
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Regional

@ Mon 1:45 - 3:00 | Barrel Room & Dean Phelps

Class Description

The CDM+ Regional program tracks data for multi-level organizations that manage data for
multiple entities, such as a state or regional office that oversees a group of local churches. We
will explore Church Records in the CDM+ desktop as well as additional data for individuals,

households, and giving units. We will also look at additions to CDM+ Mobile and Engage with
CDM+ Regional.

Class Topics

Church Records

« The Church Records Window
¢ Church Giving Units
e Church Photos

Connecting Addresses and Individuals
* Church Positions
Churches in CDM+ Mobile
* Set Up
Church Information in Engage
Reports and Notices

» Church Position Directory
» Church Position Notices

Denominational Customizations

« Christian Church (Disciples of Christ)
« Church of God - Cleveland
« United Church of Christ
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DOC Search and Call

%] v

m Mon 9:45 - 11:00 | Barrel Room & Dean Phelps

Class Description

The CDM+ Search and Call program allows regional offices of the Christian Church (Disciples
of Christ) to retrieve and share minister profiles, manage congregational profiles, and
maintain a history of activity with ministers and search committees. We will explore Ministry
Position Records and Minister Records. We will also describe how to publish and share
minister and congregational profiles.

Class Topics

On the Church Side

» Creating a New Ministry Position

» Setting Up the Search Committee

+ Using the Online Congregational Profile Tool
« Sharing the Congregational Profile

On the Minister Side

« Searching for Minister Profiles
« Flagging and Sending Minister Profiles
« Sharing the Minister Profile

Notices, Reports, and Exports
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DOC Minister Reporting

%] v

m Mon 11:15 - 12:30 | Barrel Room & Dean Phelps

Class Description

The master list of ministers is maintained in the minister database at Disciples Home Missions.
The Design stipulates that regions hold responsibility for timely reporting of minister data,
especially regarding standing and the credentialing region. The CDM+ Regional program for

the Christian Church (Disciples of Christ) is customized so that regions can both manage minister
information and report that information to the wider church through Disciples Home Missions.

Class Topics

General and Regional CDM+ Databases

» Differences
» Codes from General CDM+ Database

Individual Records for Ministers

» Minister checkbox

« DOC Minister tab

« Standing Information on the DOC Minister tab
» Church Positions on the Church tab

* Reporting Minister Changes to DHM

» Change History

When a Minister Dies or Leaves the Region
Minister Information in ALEX
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Church of God State Office Training

taty  Mon 9:45 - 4:30 | Carriage Room
@ Tue 9:45 - 4:30 | Carriage Room 6 i?:‘rg”Snedden
Wed 8:15 - 12:30 | Carriage Room

Class Description

This class is specific to staff of the State offices of the Church of God (Cleveland, TN). We will
examine importing and processing Treasurer and Minister reports, along with specific items
related to church tracking, minister tracking, and all special reports that the state office receives
from local congregations. You will also be walked through many of the programs of CDM+ and
show their application to State offices.

Class Topics
Day 1

Membership

« Address
* Individual
« Giving Unit Records
« Church Records
o ACH Setup

Reporting

» Treasurer Reports
o Import Reports
o Online Reports
o Manual Reports
« Membership Update
* Minister Reports
° Import Reports
o Online Reports
o Manual Reports
e Other Reports

Contributions

» Procedures
« Pledging
 Email Statements

Engage Giving

» Settings

« Giving
> Receiving
o Processing
o Reporting
o Failed

« Search Transactions
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Notices

Overview
What's Possible
Creating Notices
Notice Editor
Sending Notices

Day 2
General Ledger

Accounting Basics
Chart of Accounts

Creating and Finding Ledger Entries

Recurring Ledger Entries

Voiding and Deleting Ledger Entries

Bank Reconciliation
Budget
Close/Open Periods

Accounts Payable

Vendor Records
o Creating

o |nactive

o 1099

Creating and Managing Invoices

o Creating

o Marking to be Paid

o Printing and Posting
o Create Recurring
Reprinting Checks
Mobile Receipts
Reports

Payroll

Employee Setup

o Clergy Setup
Deductions Setup
Calculating Payroll
Voiding Payroll
Reprinting a Payroll Check
Adjustments to Payroll
Liabilities

Payroll Reports

Payroll Tax Forms - Aatrix
941 Report

W-2/W-3

1099
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Day 3
Reporting

« Custom Listings and Export

L]

L]

L]

L]

L]

L]

L]

Report Sets
Account Browser
Activity Reports
Balance Reports
Comparison Report
Trial Balance

Audit Trail

Event Registration

Event Records

o Activities

Entering Registrations
Registration Notices
Sent Notices

Web Ministry Tools
Reports

o Master List for Event
o Activity Report

Mobile

Overview/Availability
Provisioning
Creating

Disabling

Mobile Apps

Church Information
Pastor Information
Reminders
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